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O ver the course of the previous

21 articles, I 've introduced

the majority of the tools on

Inkscape's main toolbar. There are

a few, however, that have yet to be

described. This is mainly because

I 've found them to be less than

useful to the work I do with

Inkscape, but you may find them

invaluable. As usual, the only way

to know is to use them yourself, so,

over the next few instalments, I ' ll

do my best to give them a fair

introduction, starting

with the Tweak Tool

(shown right).

With the “T” keyboard shortcut

already assigned to the Text Tool,

the recently added Tweak Tool has

had to make do with “W” (or Shift-

F2). It's purpose, as suggested by

the name, is not to draw or create

new objects, but rather to tweak

existing ones. Its tweaks fall into

three separate modes: objects,

nodes and properties. The user

interface doesn't really distinguish

between them, but without

understanding this hidden

distinction, it's easy to become

confused about what the tool

actually does.

Objects: The Tweak Tool can be

used to move, rotate and scale

individual objects on the canvas.

Nodes: When used on a path,

the tweak tool can be used to

move nodes around, sculpting the

path shape in ways that can be

difficult to do with other tools.

Properties: The tool can be used

to change the color of objects and

the amount of blur applied to

them.

Before diving in to describe the

individual tweaks that the tool

offers, we first need some objects

to experiment on. Create a few

small rectangles, circles or stars on

the page in a fairly random

arrangement. A quick way to do

this is to draw one, then drag it

around whilst “stamping” it onto

the canvas using the Space bar.

Whatever approach you take, you

want to create a random cloud of

objects. For my example, I 've

dialled down the randomness by

using Extensions > Render > Grid…

on a larger rectangle before

manually placing my objects. This is

simply to make the sometimes

subtle effects of the Tweak Tool

stand out better.

Before using the Tweak Tool

you first have to select some

objects for it to work on. Select

some of your cloud of objects, but

leave a few unselected (or deselect

them with a Shift-click afterwards).

Now switch to the Tweak Tool

using the toolbar icon or one of the

keyboard shortcuts, and take a

look at the tool control bar (shown

below).

The Width slider sets the size of

the tool, and is reflected by a circle

around the cursor on the canvas.

This circle can be thought of as

being like a soft brush in a bitmap

editor – the effect is strongest at

the center, lessening gradually as

you move out towards the

circumference. Large sizes allow

you to change many objects or

nodes at once, though smaller sizes

provide finer control. The Force

slider allows you to set the

strength of the tweaking effect.

It's possible to change the width

and force using keyboard

shortcuts, even while drawing. The

Left and Right arrow keys change

the width, while Up and Down

change the force, and the Home

and End keys move the width slider

to its extremities. If you're using a

pressure-sensitive graphics tablet,

significant control of the force can

be achieved by enabling the button
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to the right of the slider, allowing

you to control the strength of the

force parameter with pen pressure.

The Mode section contains

buttons to select the specific type

of tweaking operation you wish to

perform. These are radio buttons –

only one can be selected at a time.

The first six buttons affect objects,

the next four affect nodes, and the

last three change properties. The

Fidelity field seems to apply only to

the node editing tweaks, despite

remaining enabled when the object

tweaks are selected. The Channels

radio buttons apply to the two

color-related property tweaks, and

remain disabled for all others.

Starting from the left, the first

of the object tweaks simply moves

the selected objects around when

they're touched by the tool.

Selecting a few of the test objects

and randomly scribbling around

with the tool results in something

like this:

If you move the cursor slowly, or

have the force set high, you can use

this mode to push objects around

indefinitely. By quickly swiping

over objects with the force set low,

you impart just a small nudge to

their positions with each pass.

The second radio button

invokes a different move mode. In

this case the objects are moved

towards the cursor, or away from

the cursor if the Shift key is held.

This is best demonstrated using a

very large width setting, so that all

the selected objects are within the

tool's brush area. By slightly

moving the cursor at the middle of

the grid, you can see that the

selected objects have all moved

towards the center (see image

below left) , while the image below

right shows the effect with the

Shift key held.

The third tweak tool moves the

selected objects randomly – that is,

by a random amount in a random

direction. The maximum distance is

constrained by the force setting.

This tool can be used with a large

width brush to affect many objects

at once, but can also be used to

more subtle effect with a small

width to introduce just a little

randomness into the positions of a

few of the selected objects.

The fourth tool shrinks objects,

or grows them if you hold Shift.

Again, a large width can be used to

shrink or grow several objects at

once, while a smaller brush allows

you to modify things with more

selectivity. For this example I chose

a small width, then wandered

around my selected objects

pressing and releasing Shift in

order to shrink some, grow others,

and leave the unselected objects at

their original size.

The last of the object-related

tweaks changes the rotation of

your selected objects. The default

is to rotate them clockwise, but as

you may have guessed you can hold

Shift to rotate them anti-clockwise

instead. The Force parameter sets

the speed at which the objects will

be rotated, though there's no

mechanism to constrain the

amount to ensure just a little

variation, nor to rotate by a

random amount to produce more

radical results in a single swipe.
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The last of the object tweaking

tools is, in my opinion, one to

avoid. It duplicates the selected

objects as you draw over them, or

deletes them when Shift is held.

Unfortunately, each duplicate is

placed perfectly on top of the

original, so if your original object is

opaque it's impossible to see how

many duplicates have been

created. It's too easy to

accidentally create many hundreds

of objects with this mode,

especially if the force parameter is

large. If you want to create a small

number of duplicates then Edit >

Duplicate (Ctrl-D) is a better

option. For lots of duplicates,

Inkscape's “Create Tiled Clones…”

dialog is a better option. Even the

deletion mode of this tweak is

equally well served by the Eraser

tool. Clones and the Eraser tool will

be described in more detail in

future articles.

I 'm going to skip over the node

tweaking tools and return to them

next time. I 'm jumping straight to

the three property tweaks because

these are applied to selected

objects rather than nodes, so I can

continue to use the same example

image to demonstrate their use.

The first of these tweaks is the

eleventh mode button on the

toolbar. Its tooltip claims that it

“Paints the tool's color upon

selected objects”, but in my

experience it's a little buggy (at

least on my 0.48.4 installation). The

tool's color can be found at the top

right of the tool control bar, to the

right of the “Channels” buttons. In

theory, it should be possible to set

the fill and stroke for the tweak

tool while the color button is

active, either using the palette at

the bottom of the screen, or the

Fill and Stroke dialog. In practice

however, it's possible to set a fill

color, but doing so will set the

stroke to black. Setting the stroke

to a color will set the fill to “None”,

which has the same effect as

having it set to black when you

actually use the tool. When used on

objects that have only a fill, it can

be used to change the fill color

without modifying the stroke.

When used on objects that have

only a stroke, it can be used to

change the stroke without

modifying the fill. But if your

objects have both, be very careful

when using this tweak unless you

want one or the other to tend

towards blackness.

With that warning out of the

way, using the tool is as simple as

selecting the mode button, picking

a target color, then painting over

the selected objects. They will

incrementally change towards the

selected color, with the speed of

the change being determined by

the tool's force setting. If you hold

the Shift button, the inverse of the

selected color will be used as the

target. This also applies to the

errant black fill or stroke, which will

become a white target instead.

The penultimate button also

affects the color of the selected

objects, but does so by randomly

jittering the color values by a small

amount. As you might expect, the

maximum size of this amount is set

by the tool's Force. For both these

color-changing tweaks, you can

further limit the effect using the

Channels buttons, labelled H, S, L

and O, which correspond to Hue,

Saturation, Lightness and Opacity

respectively. If you want to

randomise the opacity of your

objects while keeping their colors

intact, for example, you should

disable all but the O button before

painting with the tool.

The last tweak changes the blur

of the selected objects, increasing

it as you swipe over them, or

decreasing it when the Shift key is

held. This is best used with a small

value for the Force parameter,

otherwise it's easy to blur objects

so quickly that they virtually

disappear into a puff of smoke – or

rather into a slight smudge that's

barely visible on the screen.

The image on the following

page shows all three of the

property tweaks applied to the test

image. The target color for the first

test was bright green, resulting in

bright pink for the inverse color.

Compare this “directed” change of

color with the more random

selection in the second image. The

third example shows different

levels of blur as the result of

setting a small Force value and

drawing repeatedly over several of

the objects.
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Between the “objects” and

“properties” modes, the tweak tool

offers a wide range of ways to add

a little variation to otherwise

homogeneous collections of

shapes. Unfortunately it's not

possible to combine multiple

tweaks at the same time in order

to move, rotate, shrink, color and

blur some objects all in a single

operation. Being able to do so

would make more sense of the

duplicate mode – consider

duplicating and randomising the

position at the same time – but the

tool offers no such facility,

somewhat neutering its object

manipulating abilities. Where the

tweak tool is perhaps at its most

useful, however, is in dealing with

nodes in a path, which will be the

subject of the next part of the

series.

The Ubuntu Podcast covers all

the latest news and issues facing

Ubuntu Linux users and Free

Software fans in general. The

show appeals to the newest user

and the oldest coder. Our

discussions cover the

development of Ubuntu but

aren’t overly technical. We are

lucky enough to have some great

guests on the show, telling us

first hand about the latest

exciting developments they are

working on, in a way that we can

all understand! We also talk

about the Ubuntu community

and what it gets up to.

The show is presented by

members of the UK’s Ubuntu

Linux community. Because it is

covered by the Ubuntu Code of

Conduct it is suitable for all.

The show is broadcast live every

fortnight on a Tuesday evening

(British time) and is available for

download the following day.

podcast.ubuntu-uk.org

http://www.peppertop.com/shop/
http://podcast.ubuntu-uk.org/
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P reviously we looked at using

Inkscape's Tweak Tool to

change objects and properties. This

time we'll take a look at its

arguably more useful ability to

modify paths. The path tweaks are

affected by the Width and Force

sliders that were described last

time, and are chosen by selecting

one of the four buttons that I 've

outlined with a red box in the tool

control bar image shown below.

Because these tweaks modify

the nodes in a path, our previous

array of objects won't make for a

particularly useful example.

Instead we need to create a new

path or object to work on. There

are some rules, though, which

practically limit what we will draw

as an example path:

• The tweak tool works on only

closed paths. If it's used on an open

path, it will be turned into a closed

one.

• It doesn't work well on straight

paths or path segments.

• It doesn't work well on paths with

only two nodes, even if those paths

are curved.

• If it's used on an object, such as a

circle or rectangle, that object will

be converted to a path.

So our example really needs to

be a closed, curvy path with more

than two nodes. A quick option is

to use the Star tool with the

Roundness parameter turned up a

little to produce a rounded star

which will be turned into a path

when we start to tweak it.

As usual with the Tweak Tool,

you have to select the objects you

wish to work on before switching

to the tool. You don't, however,

have to select the individual nodes

you want to change – they're all

fair game for tweaking. Actually,

you'll often find that the

connected nature of nodes means

that changes will be made to the

shape of your path that extend far

beyond what the Width parameter

would imply.

With our rounded star selected,

and the “Push” tweak enabled, let's

make a couple of steady sweeps of

the tool from left to right.

It's pretty clear what has

happened: parts of the path have

been pushed away from the tool as

it moved across the shape. First the

left side was pushed into the

middle then, as the tool passed

over the boundary of the shape,

the right side was pushed further

out. Essentially the path is

distorted in the direction that the

tool is moved, and this tweak

actually feels a lot like pushing

watercolor paint around on a page

by blowing through a drinking

straw. The amount of distortion

depends not only on the Width and

Force parameters, but also on the

speed at which you move the tool.

If you move it slowly enough you

can even cut an object into

separate pieces.

At this point it's worth

introducing the Fidelity parameter,

over on the right of the tool

control bar. This controls the

number of nodes that are created

as you tweak. Manually converting

this rounded star to a path results

in 1 0 nodes. The example above

had the Fidelity set to 1 0, and

resulted in the final path having 41

nodes. Increasing Fidelity to 50 and

re-tweaking the original gave 59

nodes, while a fidelity of 80 gave
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over 1 50 nodes. Increasing the

Fidelity to 1 00 created many

thousands of nodes, and slowed

my computer down to a crawl. I

recommend keeping this value to

50 or below – the accuracy created

by the extra nodes is rarely worth

the trade-off, in my experience.

The next button on the tool

control bar is the Shrink/Grow

mode. This doesn't take its

directional cue from the movement

of the tool, but instead it will

always move nodes in towards the

center of the path – or outwards,

away from the center, if the Shift

key is held. This example used

Shrink for the top half of the star,

and Grow for the bottom half.

The penultimate node tweak is

Attract/Repel. In its normal mode,

the path is distorted as though it's

being attracted towards the center

of the tool; with Shift, the path is

instead repelled away from the

center of the tool.

This is useful for sculpting the

shape of a path. By moving the tool

around the outside of the path, you

can pull it outwards – making it

bigger. Moving it around the inside

of the path, on the other hand,

pulls it inwards – making it smaller.

Holding Shift simply reverses the

direction of the pull. Try using this

to shave away part of an object, or

to make it gently bulge outwards. If

you go too far in one direction

either hold Shift, or move the

cursor from outside the shape to

inside, or vice versa.

The final tweak promises so

much, but delivers so little. In

theory the Roughen tweak should

introduce some randomness and

chaos into the shape of your path.

What actually happens is that the

randomness largely cancels itself

out, leaving you with a lot of extra

nodes that haven't moved very far.

The best results seem to come

from using a large value for Width

in order to smother as much of the

path as you can with the tool. Even

with both the Width and the Force

at their maxima, I was still able to

produce only this:

I suppose the Roughen tweak is

living up to its name in this case.

The path certainly looks rougher in

parts. But because the effect is

stronger towards the center of the

tool, the roughness hasn't been

applied evenly around the path.

Trying to draw the tool over the

outline in an effort to spread the

effect just results in it cancelling

itself out again, producing a less

rough result. To make matters

worse, the rough areas now have

huge numbers of nodes – this

example resulted in our 1 0 node

star growing to almost 2,000

nodes!

If you do want to randomise a

path, a better option is usually to

be found in the “Jitter Nodes…”

extension. This requires a little

preparatory work because it just

moves nodes and their handles,

rather than creating them. You

have to manually create a number

of nodes beforehand, otherwise

your jittering will be rather

ineffective.

Before we can even think about

creating new nodes, we need to

ensure that our object is a path. In

the case of our example star, it's

not. That's not a problem as we've

converted plenty of shapes to

paths in the past, so it should be a

familiar operation by now: just

select the object and use Path >

Object to Path (Shift-Ctrl-C). Now

we've got a star-shaped path made

up of 1 0 nodes, but if we try to

jitter those few nodes, all we'll

succeed in doing is slightly

distorting the shape.

By switching to the Node tool

(F2), our 1 0 nodes become visible.

Next we have to select them all by

pressing Ctrl-A or using Edit >

Select All. Press the Insert key on

the keyboard and a new node will

be created between each pair of

selected nodes. Now we have 20

nodes, which is better, but still not

enough. Fortunately the newly

created nodes have automatically

been added to our selection, so all

we have to do is press Insert again,

and again, and again. 20 nodes

becomes 40, then 80, and so on. I
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stopped at 1 60 because this gave

me a fairly dense arrangement of

nodes for jittering, without asking

Inkscape to deal with excessive

numbers.

You need to switch back to the

Select tool (F1 ) and ensure your

path is selected before launching

the Jitter Nodes extension using

the menu entry: Extensions >

Modify Path > Jitter Nodes… Once

the dialog opens, the first thing to

do – and this is the case with many

of Inskcape's extensions – is to

check the “Live preview” checkbox

at the bottom. This will allow you

to modify the controls in the dialog

and see the results applied to the

canvas prior to committing them

with the Apply button.

The rest of the controls are

fairly simple. The first two

spinboxes are used to set the

amount that each node or handle

can be shifted in the X and Y

directions. Usually you would want

to set these to the same value, but

there are occasions when you want

more movement in one direction

than the other. For example,

creating a line with lots of nodes,

then jittering them in only one

direction, is a quick and easy way to

make a fake line graph.

The next two controls

determine whether the positions

of the nodes or their handles will

be shifted. Shifting the nodes gives

a more distorted line; shifting the

handles produces more spikes and

sharp transitions; choosing both

will give you a more distorted line

that also has spikes and sharp

angles. The last control simply

determines how the random shifts

are selected. If this is checked they

will follow the “bell curve” shape of

a normal distribution, meaning that

small shifts are more likely than

large shifts. In theory this can give

a more natural appearance, but in

practice the difference isn't really

noticeable in many cases.

So what of our rounded star,

now that we've converted it to a

path, added nodes and jittered it?

Well it's certainly different to the

result of the Roughen tweak, but

it's probably a lot closer to the

result you were looking for.

As I mentioned last time, I rarely

make use of the tweak tool. I find it

too difficult to control accurately,

with the effects often being far too

subtle or far too strong. Using a

pressure sensitive graphics tablet

can certainly help, as it's easier to

dynamically modify the Force as

you work, but often – as in the case

of the Roughen example – you can

get better results using other

methods.

http://www.peppertop.com/shop/
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N ext in my collection of

“Inkscape tools I rarely use” is

the zoom tool, or magnifying glass.

At this point some of you may be

wondering how I manage to use

Inkscape without using the zoom

tool, but the truth is that the

program offers so many other ways

to zoom that, although I 'm

constantly zooming in and out, I

never actually use the tool that's

dedicated to the task. Let's look at

what the tool can do first, before

examining other ways to zoom that

may mean you never use it again.

You can activate the

zoom tool by clicking on

the icon in the tool

palette, or by pressing either of

two keyboard shortcuts: F3 or Z.

Once active you can zoom in simply

by clicking within the drawing area.

To zoom back out again, hold Shift

while you click. The amount by

which you zoom in or out is fixed as

a percentage in the Steps pane of

the application preferences (File >

Inkscape Preferences). By default,

it is set to 1 41 %, although Inkscape

does round the actual zoom

amount a little so that zooming up

from 1 00% follows a sequence of

1 00% > 1 41 % > 200% > 283% >

400% > 566% > 800% and so on.

With this value zooming in twice

approximately doubles the

percentage zoom factor, but you

can change the preference to

something else if you wish.

Alternatively – and this is

probably the best way to use the

zoom tool – you can click and drag

to define the area you want to

zoom into. Inkscape's view will be

adjusted so that the rectangle

you've dragged is fully enclosed in

the window. By dragging towards

the edge of the drawing area this

feature therefore works as a

combined zoom and pan in one

operation.

That's it for the zoom tool. Two

ways to zoom in (click, or click-

drag) and one way to zoom out

(Shift-click). Admittedly there are

some buttons on the tool control

bar, but they don't actually have

any effect on the zoom tool itself.

Instead they just provide a few

useful zoom levels that are also

available via the View > Zoom

menu, even when you haven't got

the zoom tool selected.

The icon theme used on my

Linux Mint box mixes the styles of

the icons somewhat – on other

systems the first three buttons are

often styled as magnifying glasses

in the same way as the remaining

images. Regardless of the icons

used, the functionality remains the

same. Dealing with each button

from left to right – or top to

bottom if you're looking at the

View > Zoom menu – the functions

are as shown in the table below:

The Zoom In and Zoom Out

options are fairly self-explanatory:
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they're the same as clicking or

Shift-clicking with the zoom tool,

except that they are centered

around the middle of the visible

part of the canvas, rather than

around the mouse pointer.

Zoom 1 :1 might initially suggest

zooming to 1 00%, but that's not

the case. What it actually does is

zoom so that Inkscape's internal

pixel size is represented by a single

pixel on the screen – so something

drawn as 300px wide will actually

take up 300 pixels on the monitor.

This can be used so that objects

drawn using real-world units, like

millimetres and inches, will appear

at the correct size on the screen.

For it to work, however, you need

to calibrate Inkscape to your

screen using the File > Inkscape

Preferences > Interface pane. Find

a small ruler and set the units pop-

up to match. Then hold the ruler to

the screen and adjust the slider

until the on-screen measurements

match the graduations on the ruler.

It's a fiddly process, but usually

only needs to be done once. Be

aware, though, that it just

calibrates Inkscape to that one

monitor – if you replace it, or have

a multi-monitor setup you will need

to go through the process again

when you use Inkscape on a

different screen.

The Selection, Drawing and

Page options are also permanent

features of the “commands”

toolbar, so, assuming you have that

visible, there are three more

reasons why you may not need the

zoom tool. Zooming to the current

selection is clear enough, but

what's the difference between

Drawing and Page? Drawing refers

to the extent of all the objects

you've drawn. It could be smaller

than the page size, or bigger if

you've created or dragged any

shapes beyond the page's

boundary. Page is the area that's

defined in File > Document

Properties, and is usually displayed

as a rectangle with a drop shadow

in the background of the canvas –

although both the rectangle and

shadow can be turned off in the

Border section of the Document

Properties dialog, if you prefer.

Inkscape keeps track of each

zoom level you change to, and the

last two commands let you cycle

back and forth through this history.

The keyboard shortcuts use the

backtick key, which isn't commonly

used by most people – if you have

trouble finding it, it's usually at the

top left, just before the number

keys.

It's worth noting that all these

keyboard shortcuts are global: you

don't have to use the zoom tool for

them to work. So not only can you

access all these zoom options from

the View menu at any time, but

also just by pressing a few keys.

But that's not all! There are yet

more zooming shortcuts that really

make the zoom tool redundant if

you can remember them.

The tool lets you zoom in by

clicking somewhere in your

drawing, but you can achieve the

same effect without switching

tools just by clicking with the

middle mouse button or scroll

wheel. Zooming out, as you may
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guess, is achieved by Shift-clicking

the middle mouse button or wheel.

And how about the zoom tool's

one useful ability: dragging a

rectangle to define a zoom area?

Just hold shift and then click-drag

with the middle mouse button

instead.

As you can see, there's not a

single function of the zoom tool

that isn't also available globally

when you're using other tools.

Switching back and forth between

tools slows down the drawing

process, so by learning some of

these shortcuts you'll change tools

less, and speed up your work.

There are two more zoom

shortcuts that are well worth

remembering. I introduced the first

one way back in part two of this

series, but it bears repeating once

more. It's the way that I usually

zoom in and out, and I 've always

found it to be the fastest and most

convenient option if you're using a

mouse with a wheel. Just hold

down the Ctrl key and roll the

mouse wheel to make Inkscape

zoom in and out, centered on the

mouse position. When coupled

with a click-drag of the wheel to

pan the canvas you can move

around your drawing extremely

quickly.

If you've come to Inkscape from

some other vector graphics

program, you may be used to the

wheel controlling zoom without

any additional keyboard modifiers.

If you prefer this way of working,

you can change Inkscape's

behaviour via the Scrolling pane of

the Inkscape Preferences dialog.

Check the “Mouse wheel zooms by

default” option to enable this

mode, which also has the side

effect of mapping Ctrl-wheel to

panning the canvas up and down.

The last zoom shortcut is the Q

key, which activates Quick Zoom

mode. It's quick because the

zooming is only temporary: when

the key is released Inkscape will go

back to the previous zoom level.

It's particularly useful for making

minor changes to an object, or

having a close-up look at it without

losing your current context. With

no objects selected pressing Q will

double the current zoom level,

centered around the middle of the

visible canvas area. Pressing and

releasing this shortcut is like

pressing the “+” key twice to

double the zoom, followed by the

backtick key twice to revert to the

previous zoom level. With objects

selected, it behaves similarly to the

Selection zoom described above, in

that the canvas will be zoomed and

panned to ensure that the selected

objects fill the screen. Pressing,

then releasing, the Q key is

therefore similar to pressing “3”

followed by the backtick.

A quirk of Inkscape's input

focusing code affords the Quick

Zoom shortcut another little

feature. Press and hold Q to zoom

in, then move the mouse outside

the canvas area, onto a toolbar or

even outside the window entirely.

Releasing the Q key now will leave

Inkscape “stuck” at that zoom level

even when you move the mouse

back in. Essentially the canvas is

waiting to receive a message that

the Q key has been released, but

it's a message that's already been

sent and lost to another part of the

interface. You can now make your

edits without the difficulty of

holding the Q key down at the

same time. And when you're done?

Just press and release the Q key

within the canvas area once again.

It won't zoom in, as the program

still thinks the key is already

pressed, but it will finally receive

the release message it's been

waiting for, and put you back to

your previous zoom level.

Keeping track of the specific

zoom level isn't usually an issue, as

you can orient yourself by the

objects in your drawing. If you do

want to see the value, though, the

right hand side of the status bar

holds a zoom spinbox (originally

introduced in part three of this

series) . You can focus it by pressing

Alt-Z, then type in a zoom level or

use the context menu to choose a

few sensible defaults – including

yet another way to select Page,

Drawing or Selection. I suppose

that might be useful if you've

hidden the “commands” toolbar,

can't remember the keyboard

shortcuts, don't want to switch to

the zoom tool and can't find the

View menu because your Ubuntu

Unity or MacOS interface has

moved it way up to the top left of

the screen while your mouse is at

the bottom right.

I ' ll round off this article with the

last zoom related feature in

Inkscape that I know of. By default,

resizing the Inkscape window

doesn't affect the zoom, it just

reveals or hides more of the canvas

area. But there's a small toggle
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button just above the vertical scroll

bar that can be used to change this

behaviour. Toggling it on will cause

a change of the zoom value when

the window is resized, so that it

still shows the same content but at

a larger or smaller scale. It uses the

same icon as the 1 :1 zoom button,

looking like this on my Mint

system:

If you prefer the behaviour

when it's on – the zoom changing

as the window is resized – you can

set it as the default in the Windows

pane of the Inkscape Preferences

dialog. The option is towards the

bottom of the pane, and is labelled

as “Zoom when window is resized”.

Regardless of the default value,

you can still use the toggle button

to change it on a per-window basis

if you want to.

Inkscape is so replete with

shortcuts, icons and menus for

zooming that you may never need

the Zoom Tool again. But if you

struggle to remember keyboard

shortcuts or menu locations, then it

does at least provide a visual

grouping of most of the main zoom

options, so go ahead and use it if

you prefer. If there's one thing the

Inkscape developers offer in

abundance it's choice, so go ahead

and choose the approach that's

best for you.
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I n this article I 'll be looking atInkscape's 3D Box tool. The first

thing to note about the 3D Box

tool is that it doesn't create 3D

boxes. What it actually does is

draw and manipulate six closed

paths to produce a 2D

representation of a 3D box –

Inkscape is, after all, only a 2D

drawing program, not a 3D solid

CAD application. This is also the

only fake-3D drawing primitive that

Inkscape offers, so, if you want 3D

shapes other than boxes, you're on

your own. With those limitations in

mind, let's take a closer look to see

how the 3D box tool works, and

how you can use it as the basis for

more complex representations of

3D objects.

You can activate the

3D Box tool using the icon

on the toolbar, or by

pressing X or Shift-F4. The normal

2D rectangle tool can be activated

by pressing F4, so you might like to

think of this tool as drawing a

rectangle that's been shifted into

the third dimension. Depending on

where you draw, and how much

you've tinkered with the 3D Box

tool before, it's easy to create a

box that's too big or too distorted,

making it hard to understand the

tool. So before you start to draw,

let's set some sensible defaults on

the tool control bar.

The options for this tool are

deceptively simple – but that's only

because a lot of the complexity

takes place via handles on the

canvas instead. There are three

pairs of controls, consisting of a

spinbox and a button for each of

the X, Y and Z axes of the pseudo-

3D world that your box will live in.

Start by clicking all three buttons

into their “on” state. This sets an

infinite vanishing point for each

axis, ensuring that the edges of

your box are all parallel. Enter

values of 1 50, 90 and 30 into the

spinboxes – as usual there are

context menus with some sensible

options, though 1 50 isn't one of

the defaults. Now click and drag on

the canvas to draw your first 3D

box. Make it fairly large so that it's

easy to distinguish the small

handles on the box when you

release the mouse button.

There are a few things to note

about the box you've drawn: there

are red, blue and yellow

construction lines which project

from the edges along the X, Y and

Z axes of the 3D world; there are

eight small handles, one at each

corner of the cuboid (one will

appear to be in the middle of the

box – it's just the handle for the

obscured corner showing through);

there's a small X-shaped handle at

the center; finally, the box is

probably made up of shades of

blue.

Because we've set the axes to

have an infinite vanishing point,

the projection lines form parallel

pairs. The angle of each axis is

measured in degrees, in an anti-

clockwise direction where 0° points
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to the right. Compare the angles

you typed in earlier with the

projection lines – by using 30° for

the Y-axis, and 1 50° for the X-axis

(calculated as 1 80° minus 30°) , your

boxes form a classic isometric

projection. Try setting the X angle

to 1 80° for a Cavalier projection, or

set X=1 35° and Y=45° for an

Oblique projection.

The square handles are used to

adjust the size of your box. Four of

them can be used to modify two

dimensions (X and Z) at once,

whilst the other four let you

change only the third dimension

(the depth along the Y-axis) .

Holding Shift will toggle the

handles, so that a handle which

usually controls the Y dimension

instead lets you change X and Z –

and vice versa. When moving an

X/Z handle, try dragging it a little

way along one of the projection

lines, then holding Ctrl. This

constrains the movement to one

direction only, should you wish to

change the X dimension without

altering the height, for example.

The X-shaped handle can be

used to move the whole box, and

once again Ctrl can be pressed to

constrain the movement to one

axis. Usually it's best to move 3D

boxes using this handle, rather

than using the Selector tool – it

doesn't make a lot of difference for

these projections, because all the

axes have infinite vanishing points,

but once we turn off one of those

toggle buttons the behaviour of

the two methods diverges

significantly.

With the projection lines and

handles dealt with, it's time to talk

about color. The default behaviour

for the 3D Box tool is to draw your

boxes in shades of blue. You can try

setting the fill color before you

draw, but you'll still get shades of

blue. And if you set the fill color

afterwards – well, you'll get the

color you chose, but not as shades.

Rather, all six faces of your box will

be set to the same fill color and

you'll end up with something that

looks more like a flat, distorted

hexagon than a 3D box.

The secret to coloring your box

is to understand what it's made of.

The SVG format doesn't allow for

3D primitives, and certainly doesn't

know anything about 3D boxes.

What Inkscape creates is actually

an illusion, made up of six paths

that are grouped together. These

paths carry some Inkscape-specific

attributes so that the program

knows to treat them differently to

a normal group of paths, but

they're just a group of paths

nevertheless. That's why all six

sides take on the same fill when

you click on a color swatch –

they're just behaving the same way

that any group of paths does in

that situation.

The key to changing the color is

therefore to enter the group and

modify each path individually.

Whilst double-clicking with the

Select tool usually enters a group,

in this case it just switches to the

3D Box tool, so instead you need to

right-click and select “Enter Group

#g31 1 6” from the bottom of the

context menu (the exact title will

vary based on the ID of the group).

Alternatively you can click on the

box using the Selector tool, then

press Ctrl-Enter, or Ctrl-Click to

select one of the visible faces

without actually entering the

group.

Once you've entered the group,

I suggest starting by moving the

faces apart from each other. This

will give you a better idea of how

the box is constructed. Use Shift

with the arrow keys to move by a

precise amount, if you want to be

able to move the faces back to

reconstruct the box later.

While inside the group you can

also change the color of each face

individually – or even delete some

of the faces entirely. Once you're

done, exit the group by double-

clicking on the canvas background

with the Selector tool, picking “Go

to parent” from the context menu,

or using the Layers pop-up in the

status bar. You may be surprised to

find that Inkscape still considers

your object to be a 3D box even if

it's exploded, a different color, or

with faces missing. This can be

useful when you want a box with

no lid, or you just want to give each

face a stroke but no fill to create a

simple wireframe.



full circle magazine #85 23 contents ^

HOWTO - INKSCAPE

The projections we've used so

far are okay for certain types of

technical drawings or 3D pixel art,

but the 3D Box tool can also create

images with perspective. Let's start

with a simple 1 -point perspective.

We'll begin by removing the

front left face of our box (medium

blue, with the default colors) . You

should now be able to see into the

box to the pale back wall. Set your

X-axis angle to 1 80°, as we did for

the Cavalier projection, but this

time click on the parallel lines

button for the Z-axis so it's

deactivated, to give the Z-axis a

vanishing point. You'll notice that

the Z-axis angle is no longer

editable, and instead the two

yellow projection lines now

converge to a square handle on the

canvas. That's the vanishing point

(VP) – try dragging it around to see

the effect. Put it somewhere near

the center of your box to give the

appearance of looking down a

corridor. You may need to adjust

the corner handles for the best

effect.

With the 3D Box tool still

selected try drawing some more

boxes. Notice that they all share

the same VP. By moving them using

the X-shaped handle they will

continue to share their VP, but if

you move a box using the Selector

tool, the VP will also be moved,

breaking the link between that box

and any others.

Using this shared VP behaviour,

it's easy to create a few boxes with

1 -point perspective to form the

basis of a street view. You'll need

to adjust the corner handles for

each box, but remember to hold

Shift if they won't move in the right

direction.

Returning to a single box, let's

try some 2-point perspective. Draw

a new box if you need to, but this

time, toggle the parallel lines

buttons for both the X-axis and the

Z-axis. Leave the Y-axis with an

infinite VP at an angle of 90°.

Now both the red and yellow

projection lines converge into

square handles at the VPs. Drag

the handles around – for a good

effect put the red one a little

above the box and far to the left,

and the yellow one at a similar

height, but far to the right. Now

drag the box around by the X-

handle, and note what happens as

it moves above the VPs, or close to

either of them (hold Shift to move

it along the Z-axis) .

Once again, any other boxes you

draw will share the same vanishing

points. Try starting with a small box

near the red VP, then repeatedly

duplicate it (Ctrl-D) and move the

duplicates to the right along the

projection lines (hold Ctrl while

dragging the X-handle). Duplicate

again and move up, along the Y-

axis (start moving up, then press

and hold Ctrl) . Very quickly you can

build up a wall of boxes in this way

or, as I did in a recent comic strip,

leave a few gaps to create a 3D

“pixel” image.

As you may have guessed, you

can also turn off the parallel

button on the Y-axis to give you 3-

point perspective. This is not as

frequently used as the previous

options, but can be great if you

want to draw huge, imposing

towers and monoliths.

If you do move a box using the

Selector tool, you may wish to

reconnect it to the VPs of your

other boxes. Simply Shift-click on
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multiple boxes when the 3D Box

tool is active and you'll be able to

see all the VP handles at once.

Drag the handle from one box onto

the handle of another to snap

them together. Be warned, this

operation pays no heed to the

color of the handles you're

connecting, so you can easily end

up joining the X-axis of one box to

the Z-axis of another. Quite what

the result will be in any artistic or

mathematical sense, I don't know –

but feel free to experiment if you

really want to. If you decide that

you need to separate any joined

VPs, then ensure that only one box

is selected and hold Shift as you

drag the VPs around. Alternatively,

use the Selector tool to move the

whole box.

The 3D Box tool may seem quite

specific and even restricted in what

it can do, and if you take it on face

value then that's probably true.

But by setting a stroke with no fill

(and you don't even need to enter

the group to do that) , you can

create a wireframe box that makes

it much easier to draw in

perspective. So don't think of it as a

tool for drawing boxes, think of it

as a tool for drawing construction

lines. Once you've got the basic

frames for your street, wall or

tower, the rest is down to your

imagination.
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I nkscape's Spray tool is the vectorgraphics equivalent of similar

tools from the bitmap world. It's

used to create semi-random

arrangements of objects but unlike

the bitmap version, each object can

then be manipulated individually

like any other vector element. This

makes it particularly good for

quickly filling large areas with

similar items – think of a snow

flurry, or a path covered in autumn

leaves – but it can also be

invaluable on a smaller scale for

textured outlines and shapes.

The Spray tool is

activated by clicking on

the toolbox icon or by

pressing either the “A” key or

SHIFT-F3. As usual, the tool control

bar lets you modify the behaviour

of the tool using buttons and

sliders, the latter with right-click

context menus that expose a

sensible range of values and,

perhaps more importantly, label

the default values so you can

quickly get back to something

sensible.

To use the spray tool you first

need an object to spray. I 've used a

simple leaf design for this example,

made up of some paths grouped

together. Next, you need to select

your object using the select tool

before switching to the Spray tool.

With the first “Mode” button

selected, and all the sliders at their

default values, move the cursor

into the canvas area, press and

hold the left mouse button, and

move the mouse around. Copies of

your object should be sprayed onto

the screen with random scale and

rotation, which in my case

produces a pile of leaves (with the

original leaf on the left) .

The important thing to note is

that each leaf created by the Spray

tool is an independent object that

can be further manipulated. Don't

like the position of one of the

leaves? Move or delete it. If the

size is wrong, scale it using the

Select tool. Rotate it, change the

fill and stroke colors, move it up or

down in the Z-index, or group it

with a few neighbours. All the

Spray tool has done is the same job

you could have completed by

copying the original object then

pasting it multiple times, with

some simple adjustments to each

one.

If the Spray tool is just a fancy

way of doing a quick copy and

paste job, what happens when you

have more than one object

selected? In this example I 've

manually made two copies of the

leaf design and changed the colors.

Then I 've selected all three and

switched to the Spray tool, using

the same parameters as before.

You could probably have

guessed that I would get all three

leaves sprayed onto the canvas,

but look at their relative positions

and rotations: each of them is

sprayed independently of the

others. The original trilogy forms a

line with all the stalks pointing in

the same direction, but the sprayed

result doesn't preserve that

relationship between the items. In

this case that's exactly what I want

– my leafy background wouldn't

look quite the same if it was made

up entirely of regimented triplets –

but if you do want that effect you

have only to group your original

objects first. That way the Spray

tool is dealing with only a single
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(compound) object, rather than

three separate ones.

Now that you've got the basics

of the tool, let's look at the

controls that are available and the

effect that each of them has.

Starting at the left, the Mode

buttons are arguably the most

important as they dictate the way

in which your final result is actually

structured – whether you'll end up

with real objects, clones, or a single

complex path.

One of those words, “Clones”, is

a new one in this series, and it's a

subject that I 'll be covering in a lot

more depth in future articles. For

now it's sufficient to know that a

clone is like a duplicate of an object

that retains a live link to the

original: any changes made to the

original are immediately reflected

in the clones. Consider trying to

change the colors of the leaves in

our pile. With each sprayed leaf as

a copy of the original you would

need to dissect the pile and re-

color each leaf individually. If,

however, you select the second

Mode button in order to create

clones instead, then changing the

color requires you to modify only

the original. Any changes to the

original are propagated, so you can

even enter the group and tweak

the paths to change the leaf shape,

with all your modifications

immediately reflected in the

sprayed versions.

When to create clones and

when to create copies is sometimes

hard to judge. As a general rule of

thumb, though, it's usually safer to

create clones as they can

subsequently be converted into

real copies by selecting them and

then using the Edit > Clone > Unlink

Clone menu entry, whereas you

can't convert in the opposite

direction. In that same menu, the

Select Original item will select the

original “parent” object for the

currently active clone – a trick that

can be invaluable when your pile of

leaves grows large enough to

obscure the originals.

The third Mode button works

only when the object you're

spraying is a single path. Instead of

creating separate objects or clones,

it adds each sprayed item as part of

a single complex path. In this

image, the red stars have been

created as clones of the original,

whereas the green stars have been

created using this “Path” mode. As

you can see, the areas where

sprayed objects overlap differs

considerably, and in Path mode the

end result is a single path which

includes even those stars that

appear to be separate.

Having discussed the Mode

buttons, it's time to move on to the

remaining controls on the tool

control bar. With the exception of

one misplaced button, these are all

sliders which run up to 1 00 and

down to 1 or 0, depending on the

control.

The first slider, Width, simply

alters the size of the spray area.

This value is reflected in the size of

the orange circle that surrounds

the cursor when it's in the canvas

area. You can think of this circle as

containing all the possible

locations that could be used to

place the center of the sprayed

shape. Keeping it small lets you

constrain the spray close to the

cursor, whereas a large value

places the objects over a wider

area that is just centered on the

cursor.

The next slider, Amount, is used

to adjust the “speed” of your spray

can, or the number of objects that

are created over a particular

period. The button to the left can

be used to set whether or not the

Amount value is affected by the

pressure of the stylus on a

pressure-sensitive graphics tablet.

You may recall similar buttons from
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the Calligraphy tool (see Part 1 8 of

this series) and Tweak tool (Part

23), but in both those cases the

button is positioned to the right of

the slider it controls, rather than

the left. This inconsistency in UI is

likely just an oversight, but if you

do use a graphics tablet, it's worth

checking the tooltips for these

buttons to confirm exactly which

controls they affect.

The Rotation and Scale controls

are pretty obvious. Just be aware

that the values of the sliders use an

arbitrary scale running from 0 to

1 00, rather than just showing the

real numbers they represent: for

Rotation, the slider sets the

maximum amount that each copy

can be rotated from the original,

with 1 00 meaning plus or minus

1 80°; for Scale, a value of 1 00

means that the sprayed copies can

be up to twice the size of the

original. By setting both these to

zero your copies will all be identical

to one another – and to the original

object, too. It's a quick and easy

way to turn our simple leaves into a

cartoon forest.

The final two sliders affect how

the sprayed objects are distributed

over the available area. Their

effects are most visible when the

Width slider is quite large. Think of

the Spray tool as placing copies of

your object onto a circle: the Focus

slider determines the size of the

circle, and the Scatter slider

determines how close to the circle

each copy is placed.

Keeping the Scatter value low,

it's easy to see the effect of the

Focus slider. Setting it to 0 will

keep all the copies in a tight circle

under the cursor, regardless of the

Width value. Putting it all the way

to 1 00 will draw the objects around

the periphery of the spray area,

creating a ring of copies whose size

is determined by the Width

parameter. In this example, I 've

sprayed the same spot, with

Scatter=0 but with different Focus

values: the blue stars with Focus=0,

green with Focus=20 and red with

Focus=1 00.

With the Scatter control set to

zero, the copies are placed very

near to the circle that the Width

and Focus controls define.

Increasing the Scatter allows the

copies to be placed further away

from that ring – although they're

still randomly positioned, so some

will inevitably fall close to it.

Putting it all the way to 1 00 gives

Inkscape free rein to place objects

anywhere within the spray area, at

which point the Focus value ceases

to have any real effect.

The Spray tool can be very

useful for creating a random

distribution of objects or, by

constraining some of the values, a

decorative path or outline. It's a

shame that it's not possible to

control more of the parameters

using pressure or tilt on a graphics

tablet. It's also unfortunate that

the tool doesn't care about the

direction of movement – it would

be great to easily draw a line of

footprints or arrows that twist and

turn to follow your path as you

move the mouse around. Despite

those shortcomings, for certain

effects the Spray tool is invaluable,

and if you want to introduce some

randomness into your drawings it's

well worth exploring further.

http://www.peppertop.com/shop/
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B efore I dive headlong into the

last couple of items in

Inkscape's tool palette, I have a

quick update on the previous

article. Last time I drew attention

to the misleading placement of the

tablet pressure button on the

Tweak tool's control bar; but as

well as mentioning it in the article, I

did my duty as a user and filed a

bug report. I 'm pleased to say that

the bug was quickly triaged, then

fixed in just a couple of days, so the

next major release of Inkscape

should no longer suffer from this

minor anomaly.

Now, onto those last

two tools – the ones I

use least in my work

with Inkscape – starting

with the Eraser. You can switch to

this tool using either the tool

palette icon, or by pressing Shift-E.

There are barely any options

available via the tool control bar,

and the reason I rarely use this tool

is that its features are all available

via other tools anyway, albeit a

little less directly. Let's take a look

at that minimal tool control bar.

Once again the widgets are not

very intuitively positioned – the

two buttons on the right switch

between two different eraser

modes, but the Width slider on the

left actually applies only if the

second mode is selected. Time to

file another bug report...

The first mode is used to delete

entire objects from your drawing.

With this button selected, drawing

on the canvas produces a red line.

On releasing the mouse button,

any objects that the red line

touches will be removed.

If this sounds slightly familiar,

it's because similar functionality is

available using the Select tool. By

holding the Alt key whilst drawing

on the canvas with the Select tool

active, you can draw a thin red line,

with any objects the line touches

being selected when the mouse

button is released. From there, it's

just a quick tap of the Delete key

to remove them. Although the

Eraser tool is slightly more direct,

in that there is no need to press

the Delete key, performing this

task using the Select tool instead

offers you the opportunity to add

more objects to your selection – or

remove some from it – before

finally committing your deletion.

Another reason to be wary of

this mode is that it's easy to

accidentally delete too many

objects. You might think that, if

you pre-select some objects before

enabling the tool, you would be

able to selectively remove only

those that the line touches and

which were also selected. In

practice all of the selected items

will be removed as soon as you use

the tool – even if you don't touch

any of them! You can imagine how

disruptive this could be if you still

have objects selected that are

outside of the visible canvas area.

Ideally you should de-select

everything (Edit > Deselect) before

using this mode in order to prevent

such unexpected behaviour.

The second mode of the Eraser

tool is perhaps more useful: it lets

you remove parts of paths and

objects by drawing over them. The

Width slider determines the size of

the swathe that will be cut through

your path, and objects will be

automatically converted to paths

as required. Unlike the other mode,

pre-selecting objects can be useful

here as only those in the selection
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will be converted and carved.

Alternatively, ensure that nothing

is selected in order to cut through

all the visible objects.

Although this mode is handy for

quickly hacking an object into

several paths, or just carving a little

slice off the edge, the fixed width

and profile of the cutting line limits

its potential. A more flexible

approach is to use the Calligraphy

tool to create a path, then the

Boolean Difference operation to

remove it from your object. For

cutting through several objects the

Calligraphy tool can also be used

whilst holding the Alt key to switch

it to “subtract mode”, which has a

similar effect to the Eraser tool.

The only caveat is that the

Calligraphy tool doesn't always

seem to convert primitive objects

to paths when it should, so you may

have to manually convert them

first.

That's all there is to the Eraser

tool: a “touch” mode that saves a

single keypress compared with the

Selector tool approach, and a

“path” mode that is far less

functional than the Calligraphy tool

equivalent.

On to the last of the main

Inkscape tools – one which I rarely

use simply because I don't need it

for the comics I create: the

Connector tool.

The Connector tool is

used to draw lines

between objects, with

the lines being “connected” to

those objects, at least in the sense

that moving the object also moves

the end of the connector line. This

makes it a useful tool for creating

flowcharts, diagrams and

annotations, although its

capabilities are somewhat limited

when compared with dedicated

applications such as Dia, Calligra

Flow (formerly Kivio) and yEd.

To get started with the

Connector tool, it helps to have a

few objects already created.

Activate the tool via the icon or

using the “o” or Ctrl-F2 shortcuts.

As you move the mouse over

objects, you'll notice that they gain

a square handle in the center; click

and drag a line between the handle

in one object and the handle in

another to create a connector. You

can also click, then move the

mouse, then click again, but

dragging the line tends to be more

reliable. You've now connected

two objects and if you press the

Spacebar to switch back to the

Selector tool, you should be able to

move the objects around and see

that the connector line remains

attached.

The first thing to notice is that

the connector appears to emanate

from the edge of your object, even

though the connection was made

to the center. Unlike other charting

tools, Inkscape doesn't give you

any option about where on an

object the connector links to – you

always create connections using

the handle at the center, and they

visibly connect to a point on the

edge that you have no control over.

The next thing to note is that, by

default, your connector line will

happily trample right across any

objects that might lie in its path.

Inkscape offers a solution to

this by allowing you to selectively

choose objects that the connector

should avoid. First you need to

select the connector itself (you can

select more than one), then select

the objects to avoid. Now switch to

the Connector tool and click the
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first button on the tool control bar.

You should find that the

connector is now re-routed to

avoid your selected objects, and

you can use the Spacing control to

adjust the amount of clearance

that's added. If you change your

mind, you can use the second

button on the bar to specifically

allow the connector to pass

through the selected objects. With

some avoidance in place, my

sample connector now looks like

this.

It's an improvement, but it

doesn't look all that tidy. Perhaps

restricting it to only perpendicular

angles would help. With the

connector selected, the third

button – which is actually a toggle –

switches that connector between

“orthogonal” (allowing only

horizontal and vertical lines) and

“polyline” (any angle is allowed).

Enabling the toggle certainly

makes things neater, but now

there's another problem.

Because I 'd only told the

connector to avoid the green box,

it's now passing right through one

of the others. I could select the

connector and this other box, then

click the “avoid” button again, but I

usually find that a better solution is

actually to select all the connectors

and all the nearby objects, so that

you are pre-emptively telling

Inkscape to avoid them even if you

move the objects around later. This

makes it easier to draw your

diagram without constantly having

to adjust the avoidance rules. You

may need to tweak the Spacing

value to get a reasonable layout.

With an orthogonal connector and

Spacing set to zero, my chart is

starting to look more acceptable.

It's still not much of a chart

though, so I 'll add a few more

random connections. Connectors

can be styled in the same way as

any other path in Inkscape, so I 've

changed line colors, widths and

dashes as well as adding some End

markers to provide arrow-heads. To

get the arrow-heads to match the

colors of the lines, I 've used

Extensions > Modify Path > Color

Markers to Match Stroke, and

added some shape to the lines

using the Curvature setting in the

Connector's tool control bar. Now

that's what I call a chart!

Once you've used the

Connectors tool to forge links

between objects in your chart or

diagram you can also let Inkscape

have a try at arranging it for you.

The button on the control bar

between Spacing and Length

triggers this layout algorithm, with

the Length value and the two

remaining buttons affecting the

final result. These latter controls

aren't interactive, so you need to

re-trigger the layout algorithm by

pressing the button each time you

change any of them. The layout

algorithm only on only selected

connectors and objects, which can

be handy if you just want to tidy up

part of a complex diagram, but can

also result in a complete mess so
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make sure you save first. By

selecting all of my chart and

pressing the trigger button you can

see that it's not really as complex

as it initially appears.

Don't be too impressed by that

result: I had to cheat to get the

chart looking that neat. Inkscape's

algorithm spread the three arms of

the diagram out quite widely,

creating an unnecessarily sprawling

image. Nevertheless it provided a

clearer view of the relationships I

had randomly drawn, making it

easy to move the boxes around to

give this more professional looking

result.

The three controls that you

have over Inkscape's own

algorithm don't really amount to

much. The Length parameter lets

you adjust the preferred length of

the connectors in the rearranged

drawing. Unfortunately it's easy to

go too low with this value, as it

doesn't seem to follow a very linear

scale, which results in boxes

nestled far too close to each other.

Just increase the value and hit the

trigger button again if that

happens to you.

The first of the control buttons

tries to adjust the algorithm so that

lines with end markers will always

tend downwards. This doesn't work

for start markers, so make sure you

draw from source to destination if

you want to use this mode.

Enabling this and pressing the

trigger results in this layout for my

chart... after a little manual

adjustment, once again.

The final button tells the

algorithm that shapes aren't

allowed to overlap. This didn't

prove to be a problem with my test

chart, but if you prefer to not have

the shapes in your diagram

overlapping one another, it's

probably best to enable this option

anyway.

There are a couple of final

things to note about the Connector

tool: first, it's one of the more

unstable parts of Inkscape. It can

cause crashes, mess up the undo

buffer, and produce results that

are quite removed from your

intentions! Make sure you save

frequently if you use it. Secondly,

you can't convert the connectors

into “normal” paths using Edit >

Object to Path, as you might

expect. You can still manipulate

the path's nodes manually by

selecting a connector then

switching to the Node tool, but any

changes can be lost if you move the

linked object or click the trigger

button.

You may find the Connector

tool useful for simple diagrams,

but I usually find that such simple

connections are just as easy to

draw and modify manually, with no

need for automatic layout

algorithms. Once you reach a level

of complexity where such facilities

are useful, it's probably time to

switch to a dedicated application

instead.

http://www.peppertop.com/shop/
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I n this article, I 'm going to start

looking at clones in Inkscape.

Clones can easily be dismissed as a

minor feature, but, with a few

tricks, you can use them to perform

marvellous feats that make them

worthy of several articles just to

cover the basics.

At the simplest level, a clone is

nothing more than a duplicate of

an Inkscape object that maintains a

link to the original. Changes to the

original are automatically

propagated to the clone, making

them ideal when you need several

identical objects in an image.

Creating a clone is as simple as

selecting the object and using the

Edit > Clone > Create Clone menu

entry, or just pressing the Alt-D

keyboard shortcut. The new clone

will be created directly on top of

the original object, and will be

selected automatically so that you

can immediately move it to

somewhere else.

With a clone selected, the Edit >

Clone > Select Original menu item

(or Shift-D shortcut) will select the

original object with which the clone

is linked – its “parent” if you like.

This now gives us a collection of

related keyboard shortcuts that

are well worth memorising to

speed up your work with Inkscape:

Ctrl-X - Cut to clipboard
Ctrl-C - Copy to clipboard
Ctrl-V - Paste from clipboard
(at the mouse position)
Ctrl-Alt-V - Paste In Place
(at the object's position)
Ctrl-D - Duplicate (copy then
paste in place)
Alt-D - Clone (a linked
duplicate)
Shift-D - Select Original

Initially the Paste In Place

option seems a little redundant,

given that the Duplicate command

appears to achieve the same result.

The difference is that Paste In

Place also works between layers,

and even between Inkscape

documents, so you can copy or cut

from one drawing's layer, then

paste into the same location in a

different layer or a different

drawing.

So much for the theory, let's

create a duplicate and a clone and

see the difference between them.

For notational purposes, I 'm going

to use a solid arrow pointing from

the parent object to the duplicate,

and a dashed arrow pointing from

the parent object to the clone.

With this notation the “Select

Original” command always follows

back from the tip of a dashed

arrow to its source. Here's a simple

parent object with a single

duplicate and a single clone.

As you might expect, all three

objects look the same. The

difference only becomes apparent

when the parent object is modified

in some way – such as changing it's

fill and stroke, or altering the

roundedness of the corners.

Our duplicated object, which

maintains no link to the parent,

remains unaffected. The clone,

however, is immediately updated

to reflect the changes to its parent

object. That makes it useful for

creating absolutely identical

objects – hence the term “clones” –

but, as in real life, it's possible for

Inkscape's clones to develop slight

differences to their parents. A

clone, as well as maintaining a link

to its parent, is also an object in its

own right, and is subject to the

same transformations as any other

object. Clones can be rotated,

scaled and skewed, have their

opacity reduced, or have filters

applied, independently of the

parent. With some rotation, scaling

and opacity changes applied to the
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like this.

It's important to note that these

changes are applied after the clone

has been synchronised with its

parent – you can think of them as

being added on to the base

attributes of the parent. So the

clone's fill and stroke colors will

still change if the parent's are

modified, and any rotation, blur

and opacity changes to the parent

have a cumulative effect with

those that are applied to the clone.

For example, this clone has a 45°

rotation applied; if I were to rotate

the parent by 1 5° then the clone

would also rotate by an additional

1 5° bringing its total rotation to

60° compared to its original

position.

One simple but effective use of

this feature is to create drop

shadows by blurring a clone and

reducing its opacity. This is

especially beneficial when dealing

with text objects as the shadow will

automatically adjust to any edits

you may make to the text content.

If a clone is just another type of

object, then surely it must be

possible to copy and paste it. If

that's possible, then what about

duplicating it, or even cloning it?

The simple answer is that you can

do all these things with clones, but

the results might not always be

what you expect. You can create

long chains of relationships –

clones of clones of clones... of

clones of objects – but the

cumulative nature of any applied

transformations can result in a

small tweak to one item having a

knock-on effect all the way down

the chain.

To keep things simple, I ' ll just

look at a basic three object chain

where a grandparent is duplicated

or cloned to form a parent which is,

in turn, duplicated or cloned to

create a child. I 've drawn all the

possible combinations, and given

each object or clone a number so

that it's easier to track what's

happening. Starting with the basic

arrangement of objects, as with the

earlier two-object example, all the

elements look the same, whether

they've been duplicated or cloned.

(1 ) is the starting point, our

grandparent object. This is

duplicated to create (2), and cloned

to create (3). Each of those objects

is duplicated and cloned to

produce the remaining items. The

provenance of each object is

therefore:

(1 ) The original grandparent object.

(2) A duplicate of (1 ) . Parent to (4) and (5)
(3) A clone of (1 ) . Parent to (6) and (7)
(4) A dupe of a dupe of (1 )
(5) A clone of a dupe of (1 )
(6) A dupe of a clone of (1 )
(7) A clone of a clone of (1 )

What happens when we modify

the attributes of (1 )? As before, our

duplicated object (2) remains

unaffected, so (4) and (5) also

appear untouched. The first-level

clone (3) changes, as does its clone

(7). But what about (6)? That was

made as a duplicate, so you might

expect it not to change, yet you can

clearly see that it does.

The thing to bear in mind is that

(6) is an exact duplicate of (3) –

even down to its linkage to the

grandparent object (1 ) ,

represented by the gray line on the

image. You can see, therefore, that

a second clone of an object can be
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created either by cloning the

object a second time, or by

duplicating an existing clone. The

difference is that duplicating a

clone will also duplicate any other

attributes associated with it, so if

you've rotated the clone or added

a blur, those effects will be present

on the new clone, even though it's

linkage goes back to the

grandparent object.

Now let's look at what happens

if we modify (2) and (3). For this

example I 've rotated them through

45°.

(4) remains the same, because it

has no linkage to any of the other

objects. (5) rotates because it's a

clone of (2). The linkage between

(6) and (1 ) means that it's not

affected by the rotation of (3) –

although it would be affected if (1 )

were to be modified. Finally (7)

does rotate because, as a clone of a

clone, it's made up of the

cumulative effects of all the

changes made to both (1 ) and (3).

If that's not enough to make

your head spin, I ' ll leave it as an

exercise for the reader to consider

chains of four or more objects!

One good reason for using

clones is that they tend to be less

resource hungry than the

equivalent separate objects. In

terms of storage space, a clone is

little more than a reference to

another part of the SVG content,

helping to keep the file size down.

This can be particularly useful when

you're dealing with complex paths,

groups or embedded images.

Consider this example that uses a

single image and some cloning,

rather than embedding three

separate images.

The left hand image is the

parent in this case. The top right

image is the result of cloning the

parent, then scaling the clone

before applying a clipping path.

The bottom right image is the

result of cloning the clipped clone

and applying a second clipping path

to that. The same effect could also

have been achieved by clipping a

second clone of the parent, but I

also wanted to demonstrate that a

clone of a clipped or masked object

still retains the clipped appearance

– note the curved sides of the

bottom right image that result

from the elliptical clipping path

used on the top image.

Although clones can result in

substantial space savings, chaining

them too deeply can slow

Inkscape's rendering of your image.

In the case of the Mona Lisa

example, it's clear that the bottom

right image can't be processed

until after the top one – including

its clipping path – has been

calculated. Extending the chain

further to create clones of clones

of clones just exacerbates the

problem. Unless your design really

does require the sort of attribute

inheritance that such chains

enable, you're better to create

clones that link directly back to a

common parent.

Remember, either clone from

the original parent each time (Alt-

D), or clone once then duplicate

the clone (Ctrl-D). If you're not sure

whether you're cloning the original

object or an existing clone of it,

check the status bar. If it reads

“Clone of Clone of Clone...” then

you might want to re-think your

approach.

http://www.peppertop.com/shop/
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